Your Uninstaller! PRO 2010 v7.0.2010.7 + Keygen





Your Uninstaller! 2010! Là một chương trình tháo gỡ cài đặt hàng đầu trong ngành. Nó là một chương trình tháo gỡ cài đặt Drag & Uninstall™ trên nền Windows thông minh nhất thế giới, đây là "Windows XP Optimized" (Windows XP được tối ưu hóa) và cũng hoạt động trên các phiên bản Windows khác gồm Windows XP/2000/ME/98/95/2003. Sử dụng nó cũng dễ như sử dụng thùng rác (recycle bin). Hãy tưởng tượng! Chỉ cần kéo-thả và chương trình mà bạn không muốn sử dụng nữa sẽ biến mất trong máy bạn—cũng như tất cả những gì không muốn mà chương trình đó đã mang lại! Your Uninstaller! là một cách tháo gỡ những ứng dụng không cần đến trên máy tính của bạn rất thân thiện với người sử dụng. Nó còn có thể tháo gỡ những phần mềm gián điệp gây rắc rối!

Phần mềm Your Uninstaller! được thiết kế đặc biệt cho cả người mới sử dụng cũng như những người sử dụng chuyên sâu. Your Uninstaller! 2010 cực kỳ nhanh và rất dễ dùng. Nó có một khả năng độc đáo để gỡ bỏ những phần mềm đơn giản bằng cách kéo biểu tượng ủa chương trình đó vào biểu tượng của Your Uninstaller! Bạn cũng còn có thể tìm ứng dụng mà bạn muốn gỡ bỏ qua chức năng tìm kiếm độc đáo.

Your Uninstaller! gỡ bỏ hoàn toàn nhữnh ứng dụng một cách nhanh chóng. Your Uninstaller! khởi động nhanh hơn 500%-1000% lần so với các chương trình Add/Remove khác. Như bạn biết, có rất nhiều bộ cài đặt trên thế giới, chẳng hạn như InstallShield, Wise Installer, Microsoft Installer và nhiều phần mềm khác. Hầu hết các ứng dụng được xây dựng sử dụng các trình cài đặt này. Mỗi trình cài đặt có một cơ sở dữ liệu cài đặt riêng, điều đó gây khó khăn cho việc tìm kiếm các thay đổi mà chương trình tạo ra cho máy tính của bạn. Đó là lý do tại sao các trình gỡ bỏ cài đặt khác chỉ có thể tháo gỡ một phần các file còn lại của ứng dụng và những từ khóa registry.

Để giải quyết vấn đề này,Your Uninstaller! sử dụng kỹ thuật độc đáo của nó: SmartUninstall™. SmartUninstall™ có một cơ sở dữ liệu bao gồm các thông tin về tất cả các trình cài đặt trên thị trường; nhờ vậy khi tháo gỡ một chương trình, nó tự động dò tìm trình cài đặt nào mà ứng dụng đó đã dùng, sau đó nó tháo gỡ ứng dụng đó một cách thích hợp và đơn giản. Đó là lý do tại sao Your Uninstaller! có thể dò tìm và tháo gỡ hoàn toàn tất cả các chương trình và biểu tượng trên máy tính của bạn.
Đặc tính chính:
Tháo gỡ hoàn toàn bất kỳ ứng dụng nào đã được cài đặt.
Quét sâu vào registry và toàn bộ đĩa để tìm các file và các phần nhập vào registry.
Tháo gỡ các chương trình mà Add/Remove Program không thể gỡ bỏ.
Tháo gỡ các screen savers.
Thể hiện tất cả các ưng dụng đã cài đặt trên máy tính của bạn với cửa sổ tùy chỉnh. Chương trình Disk Cleaner tích hợp giúp bạn tìm và gỡ bỏ những file không cần thiết trên đĩa cứng của bạn để tiết kiệm đĩa và làm cho máy tính bạn nhanh hơn!
IE Context Menu Cleaner tích hợp, dọn dẹp menu ngữ cảnh của Internet Explorer.
Tích hợp Startup Manager, kiểm soát các phần khởi động của Windows.
Tích hợp Start Menu Manager giúp bạn giữ sạch Start Menu.
Thu thập các thông tin chi tiết về các ứng dụng ngay cả trong trường hợp nó tự ẩn sâu trong các thư mục, đặc biệt hữu dụng cho việc tìm kiếm các ứng dụng “Gián điệp”.
Sao lưu/Phục hồi thông tin các hứng dụng cài đặt.
Tháo gỡ cài đặt với chức năng kéo-thả! Chỉ cần thả một file lên biểu tượng Your Uninstaller! trên desktop và bạn sẽ thấy những gì xãy ra!
Liệt kê các ưng dụng đã được cài đặt với các biểu tượng thích hợp (giống như bạn thấy trong Start Menu), bạn có thể tìm ứng dụng mà bạn muốn tháo gỡ dễ dàng.
Tính năng tìm kiếm mạnh mẽ cho phép bạn tìm chương trình bạn muốn tháo gỡ nhanh chóng.
Tự động dò tìm các sự cài đặt không hợp lệ và tháo gỡ chúng chỉ với một cú click.
Gỡ bỏ bắt buột các giá trị nạp vào trong registry liên quan đến việc tháo gỡ cài đặt (cẩn thận khi dùng)!
Khởi động cực nhanh, từ 5-10 lần nhanh hơn Add/Remove Program của Windows XP!
Xem tất cả các chi tiết của một ứng dụng nào đó được cài đặt trên máy tính của bạn.
Xuất danh sách các chương trình thành file hoặc in ra.

Link:

Quote:
http://www.mediafire.com/?zmykdjjnloy
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Your Uninstaller! 2010 Pro 7.0.2010.11

Gỡ gỏ chương trình đến tận răng

Với Your Uninstaller! 2010 (YU), bạn có thể nhanh chóng gỡ bỏ những phần mềm cứng đầu ra khỏi máy tính. Chức năng Hunter Mode mới được bổ sung giúp bạn gỡ bỏ, tắt tiến trình một cách thuận tiện nhất. Tốc độ hoạt động của chương trình cũng được cải thiện, tăng 30% so với 
phiên bản trước
.


Cải tiến dễ nhận thấy nhất là giao diện YU 2010 được tút lại khá đẹp mắt. Thanh tìm kiếm bên trên giúp bạn tìm nhanh một phần mềm, bạn chỉ cần gõ một từ khóa thì danh sách các phần mềm liên quan sẽ hiện ra. Các phần mềm đã cài sẵn trong máy được sắp xếp trong khung Installed Programs bên phải, khi bạn nhấn chọn một chương trình thì khung Details bên trái thể hiện cho bạn biết các thông tin về chương trình đó. Để gỡ bỏ nó, chọn Uninstall. 

Hộp thoại Select Uninstall Mode sẽ cho bạn lựa chọn 4 chế độ:

· Built-in Mode: Sử dụng trình gỡ bỏ mặc định của phần mềm đó

· Safe Mode: Gỡ bỏ phần mềm, kèm theo việc xóa registry thừa ở mức độ đơn giản

· Normal Mode: Dò tìm sâu hơn trong registry và file rác.

· Super Mode: Là chế độ gỡ bỏ phần mềm triệt để nhất, xóa mọi dấu việt của chúng trên máy tính, tuy nhiên tốc độ hoạt động chậm nhất.



Sau khi đã lựa chọn một chế độ phù hợp, chương trình sẽ chuyển qua khâu sao lưu dự phòng hệ thống, đề phòng trường hợp bạn cần sử dụng lại phần mềm đó sau này.

- Hunter Mode là chức năng mới độc đáo trong YU 2010, giúp bạn nhanh chóng gỡ bỏ, tắt một tiến trình (process) đang chạy. Bạn click Hunter Mode, trên màn hình sẽ hiện ra icon tầm ngắm. Bạn chỉ việc kéo icon này vào shortcut của chương trình trên desktop, hoặc khay hệ thống (system tray).Một loạt các tác vụ liên quan sẽ hiện ra, cho phép bạn thao tác.

- Một vài phần mềm khi cài đặt sẽ xảy ra lỗi. Bạn nhấn lên biểu tượng dấu chấm than màu vàng, rồi chọn AutoFix để sửa.

- Ngoài chế độ gỡ bỏ thông thường, bạn nhấn Advanced Uninstall để gỡ bỏ các phần mềm không hiển thị trong danh sách, hoặc đã gỡ bỏ nhưng không thành công (lỗi thường gặp ở các phần mềm diệt virus).
Download:
http://www.mediafire.com/?urhi5bhjkqt
hoặc 

Your_Uninstaller_2010.6_PRO_incl_patch_keygen.rar
eCHIP – Duyphuong.net
Your Uninstaller! 2010 có gì mới? 

TTO - Your Uninstaller ! từ lâu được biết đến như công cụ gỡ bỏ ứng dụng hàng đầu với cách sử dụng rất đơn giản (kéo và thả). Phiên bản 2010 vừa được trình làng tiếp tục khắng định vững chắc vị trí của công cụ này. 

Những cải tiến đáng giá của Your Uninstaller! 2010 gồm: giao diện trực quan hơn, cho phép tùy biến chế độ gỡ bỏ ứng dụng theo sự kỹ càng hay tốc độ, bổ sung tính năng loại bỏ thư rỗng còn sót lại sau khi gỡ ứng dụng, chế độ Hunter - hỗ trợ gõ ứng dụng bằng cách kéo thả theo phương thức mới và công cụ xóa file/thư mục vĩnh viễn (File Shredder). 

Hơn thế, bốn tiện ích từng có mặt trong phiên bản trước là Disk Cleaner (quét dọn file rác), Startup Manager (kiểm soát đối tượng khởi động cùng Windows), xóa dấu vết lướt web và khai thác Windows ( Trace Eraser ), ẩn các thư mục trên Start menu (Start Menu) nay cũng được nâng cấp để làm việc hiệu quả hơn. 

	

	


Bạn tải bản dùng thử của Your Uninstaller! 7.0.2010.3 tại đây (dung lượng 5,2MB, tương thích với mọi Windows, kể cả Windows 7). 

Sau khi cài xong Your Uninstaller! 2010, trên desktop chỉ xuất hiện duy nhất shortcut Your Unin-staller! Bạn nên tạo thêm shortcut Your Uninstaller! - Hunter Mode trên desktop nhằm tiện bề khai thác chế độ kéo thả để gỡ bỏ chương trình, bằng cách vào Start menu> All Programs> Your Uninstaller! 2010 , bấm phải chuột vào shortcut Your Uninstaller! - Hunter Mode và chọn lệnh Send to> Desktop . 

Để gỡ bỏ chương trình bất kỳ, bạn có thể thực hiện theo một trong cách sau: 

Cách 1. Nhấp đôi vào shortcut Your Unin-staller!, bấm Continue để mở giao diện chính của Your Uninstaller! 2010, rồi nhấp đôi vào tên chương trình muốn gỡ bỏ. 
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	Gỡ bỏ chương trình bắng cách kéo thả 



Cách 2 . Nhấp đôi vào shortcut Your Uninstaller! - Hunter Mode , bấm nút Continue, kéo shortcut của chương trình muốn gỡ rồi thả vào biểu tượng vừa xuất hiện phía trên góc phải, tiếp đó chọn lệnh Uninstall> Yes (có sự khác biệt so với phiên bản trước). 

Lưu ý: Theo thử nghiệm, ba lệnh Stop Autorun (loại bỏ chương trình khỏi danh sách khởi động cùng Windows), Kill Process (tắt tiến trình chạy nền của chương trình), Kill & Delete Process (tắt và xóa luôn tiến trình chạy nền của chương trình) không chỉ không công hiệu, mà Kill Process còn có thể làm các biểu tượng trên desktop biến mất, nên tốt nhất bạn đừng đụng vào.  
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	Chọn chế độ gỡ chương trình


Với hai cách nêu trên, sau khi hộp thoại Select Uninstall Mode hiện ra, bạn lựa chọn một trong bốn chế độ: 

+ Built-In Mode : chế độ gỡ bỏ chương trình được nhà sản xuất tích hợp sẵn, không tìm xóa các khóa registry và file/thư mục liên quan. 

+ Safe Mode : chế độ gõ bỏ chương trình an toàn của Your Uninstaller! 2010 (tương tự kiểu gỡ bỏ của phiên bản Your Uninstaller! 2008 hay 2009), bao gồm chế độ Built-In Mode và tìm xóa những khóa registry và file liên quan đến chương trình ở cấp độ đơn giản. 

+ Normal Mode : gồm chế độ Safe Mode và tìm xóa những khóa registry, file liên quan đến chương trình ở cấp độ nâng cao, do đó tốc độ làm việc sẽ chậm hơn chế độ Safe Mode. 

+ Super Mode : gồm chế độ Normal Mode và tìm xóa những khóa registry, file liên quan đến chương trình trên toàn hệ thống; tốc độ làm việc chậm nhất nhưng sẽ quét sạch tận gốc mọi dấu vết của chương trình. 

Chọn xong, bạn bấm Next để thực hiện. Nếu đang bật chức năng System Restore , quá trình tạo điểm khôi phục hệ thống sẽ diễn ra sau đó, để sau này bạn có thể phục hồi chương trình vừa gỡ thông qua menu Tools> Rescue Center . 

Cách 3 . Từ giao diện chính của Your Uninstaller! 2010, bạn có thể rê chuột vào tên chương trình muốn gỡ và bấm nút Quick Uninstall phía dưới để áp dụng chế độ gõ nhanh, gồm chế độ Built-In Mode và tự động tìm xóa luôn những khóa registry, file liên quan đến chương trình, không bắt bạn thực thi bằng tay như ba chế độ Safe Mode, Normal Mode, Super Mode. 

Khi gỡ bỏ xong một chương trình (bao gồm tàn dư), bạn nhớ bấm nút Emty Gone phía dưới để xóa luôn thư rỗng còn sót lại của chương trình đó (thường nằm trong thư mục Program Files). Trong hộp thoại mở ra, bên cạnh thư mục rỗng của chương trình vừa gỡ, thư mục rỗng của những chương trình khác vừa xóa (nếu có) cũng được liệt kê. Bạn bấm OK để hoàn tất. 
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	Xóa thư rỗng của chương trình vừa gỡ 


Lưu ý: 
- Với bản dùng thử, ở mỗi phiên khởi động, Your Uninstaller! 2010 chỉ cho phép bạn gỡ bỏ hai chương trình theo cách 2, nhưng không giới hạn số lượt gỡ bỏ chương trình theo cách 3.   

- Nút Hunter Mode để chuyển Your Uninstaller! 2010 sang chế độ Hunter Mode. Lúc ấy, biểu tượng Your Uninstaller! 2010 sẽ xuất hiện trên khay hệ thống, còn biểu tượng hỗ trợ gõ bỏ chương trình bằng cách kéo thả thì nằm phía trên góc phải desktop. 

- Nút Advanced Uninstall giúp bạn gỡ bỏ những ứng dụng không xuất hiện trong danh sách Add/Remove Programs của Windows, hoặc không thể gõ bỏ theo cách bình thường (trong đó có các bản vá của Windows, Microsoft Office). 

- Để cập nhật danh sách ứng dụng mới cài đặt trong khi đang mở Your Uninstaller! 2010, bạn bấm nút Refresh. 

- Muốn mở nhanh một số công cụ có sẵn của Windows, bạn bấm nút Windows Tools. 

- Bạn vào menu Tools> Options (hoặc nhấn Alt + O) để mở hộp thoại cấu hình nâng cao Your Uninstaller! 2010. 
Your Uninstaller! 2010 Pro 7.0.2010.11 - Gỡ bỏ những chương trình "cứng đầu"
Với Your Uninstaller! 2010 (YU), bạn có thể nhanh chóng gỡ bỏ những phần mềm cứng đầu ra khỏi máy tính. Chức năng Hunter Mode mới được bổ sung giúp bạn gỡ bỏ, tắt tiến trình một cách thuận tiện nhất. Tốc độ hoạt động của chương trình cũng được cải thiện, tăng 30% so với phiên bản trước.


Giao diện Your Uninstaller! 2010 Pro 7.0.2010.11
Cải tiến dễ nhận thấy nhất là giao diện YU 2010 được tút lại khá đẹp mắt. Thanh tìm kiếm bên trên giúp bạn tìm nhanh một phần mềm, bạn chỉ cần gõ một từ khóa thì danh sách các phần mềm liên quan sẽ hiện ra. Các phần mềm đã cài sẵn trong máy được sắp xếp trong khung Installed Programs bên phải, khi bạn nhấn chọn một chương trình thì khung Details bên trái thể hiện cho bạn biết các thông tin về chương trình đó. Để gỡ bỏ nó, chọn Uninstall. 

Hộp thoại Select Uninstall Mode sẽ cho bạn lựa chọn 4 chế độ:

· Built-in Mode: Sử dụng trình gỡ bỏ mặc định của phần mềm đó

· Safe Mode: Gỡ bỏ phần mềm, kèm theo việc xóa registry thừa ở mức độ đơn giản

· Normal Mode: Dò tìm sâu hơn trong registry và file rác.

· Super Mode: Là chế độ gỡ bỏ phần mềm triệt để nhất, xóa mọi dấu việt của chúng trên máy tính, tuy nhiên tốc độ hoạt động chậm nhất.

Sau khi đã lựa chọn một chế độ phù hợp, chương trình sẽ chuyển qua khâu sao lưu dự phòng hệ thống, đề phòng trường hợp bạn cần sử dụng lại phần mềm đó sau này.

- Hunter Mode là chức năng mới độc đáo trong YU 2010, giúp bạn nhanh chóng gỡ bỏ, tắt một tiến trình (process) đang chạy. Bạn click Hunter Mode, trên màn hình sẽ hiện ra icon tầm ngắm. Bạn chỉ việc kéo icon này vào shortcut của chương trình trên desktop, hoặc khay hệ thống (system tray).Một loạt các tác vụ liên quan sẽ hiện ra, cho phép bạn thao tác.

- Một vài phần mềm khi cài đặt sẽ xảy ra lỗi. Bạn nhấn lên biểu tượng dấu chấm than màu vàng, rồi chọn AutoFix để sửa.

- Ngoài chế độ gỡ bỏ thông thường, bạn nhấn Advanced Uninstall để gỡ bỏ các phần mềm không hiển thị trong danh sách, hoặc đã gỡ bỏ nhưng không thành công (lỗi thường gặp ở các phần mềm diệt virus).

Trần Đính - eCHIP 464
DuyPhuong.Net (tóm tắt)


(Đây là bản Portable - Chạy trực tiếp không cần cài đặt)
Các Bài Viết Liên Quan - DuyPhuong.Net
Norton Ghost 15.0.0.35659 Full
VirtualDrive Pro 12 Full + Keygen
WinXP Manager 6.0.7 Full (Keygen)
Unikey 4.0 đã có bản RC2
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	Gỡ bỏ bản vá của Windows và MS Office



- Bạn có thể xuất danh sách tất cả chương trình có trong giao diện Your Uninstaller! 2010 dưới dạng file text, bằng cách vào menu File> Export Application List , rồi bấm Save To File . 

- Các lệnh trên menu View hỗ trợ thay đổi cách hiển thị danh sách chương trình. 

QUANG VÂN 
	Portable Your Uninstaller! 2010 Pro 7.0.2010.8 
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Portable Your Uninstaller! 2010 Pro 7.0.2010.8! Là một chương trình tháo gỡ cài đặt hàng đầu trong ngành. Nó là một chương trình tháo gỡ cài đặt Drag & Uninstall™ trên nền Windows thông minh nhất thế giới, đây là "Windows XP Optimized" (Windows XP được tối ưu hóa) và cũng hoạt động trên các phiên bản Windows khác gồm Windows XP/2000/ME/98/95/2003. Sử dụng nó cũng dễ như sử dụng thùng rác (recycle bin). Hãy tưởng tượng! Chỉ cần kéo-thả và chương trình mà bạn không muốn sử dụng nữa sẽ biến mất trong máy bạn—cũng như tất cả những gì không muốn mà chương trình đó đã mang lại! Your Uninstaller! là một cách tháo gỡ những ứng dụng không cần đến trên máy tính của bạn rất thân thiện với người sử dụng. Nó còn có thể tháo gỡ những phần mềm gián điệp gây rắc rối!


Your Uninstaller! gỡ bỏ hoàn toàn những ứng dụng một cách nhanh chóng. Your Uninstaller! khởi động nhanh hơn 500%-1000% lần so với các chương trình Add/Remove khác. Như bạn biết, có rất nhiều bộ cài đặt trên thế giới, chẳng hạn như InstallShield, Wise Installer, Microsoft Installer và nhiều phần mềm khác. Hầu hết các ứng dụng được xây dựng sử dụng các trình cài đặt này. Mỗi trình cài đặt có một cơ sở dữ liệu cài đặt riêng, điều đó gây khó khăn cho việc tìm kiếm các thay đổi mà chương trình tạo ra cho máy tính của bạn. Đó là lý do tại sao các trình gỡ bỏ cài đặt khác chỉ có thể tháo gỡ một phần các file còn lại của ứng dụng và những từ khóa registry
Download Here - Updated by TTNDteam
Để giải quyết vấn đề này,Your Uninstaller! sử dụng kỹ thuật độc đáo của nó: SmartUninstall™. SmartUninstall™ có một cơ sở dữ liệu bao gồm các thông tin về tất cả các trình cài đặt trên thị trường; nhờ vậy khi tháo gỡ một chương trình, nó tự động dò tìm trình cài đặt nào mà ứng dụng đó đã dùng, sau đó nó tháo gỡ ứng dụng đó một cách thích hợp và đơn giản. Đó là lý do tại sao Your Uninstaller! có thể dò tìm và tháo gỡ hoàn toàn tất cả các chương trình và biểu tượng trên máy tính của bạn.
Các đặc tính chính của Portable Your Uninstaller! 2010 Pro 7.0.2010.8 :
• Tháo gỡ hoàn toàn bất kỳ ứng dụng nào đã được cài đặt.
• Quét sâu vào registry và toàn bộ đĩa để tìm các file và các phần nhập vào registry.
• Tháo gỡ các chương trình mà Add/Remove Program không thể gỡ bỏ.
• Tháo gỡ các screen savers.
• Thể hiện tất cả các ưng dụng đã cài đặt trên máy tính của bạn với cửa sổ tùy chỉnh. Chương trình Disk Cleaner tích hợp giúp bạn tìm và gỡ bỏ những file không cần thiết trên đĩa cứng của bạn để tiết kiệm đĩa và làm cho máy tính bạn nhanh hơn!
• IE Context Menu Cleaner tích hợp, dọn dẹp menu ngữ cảnh của Internet Explorer.
• Tích hợp Startup Manager, kiểm soát các phần khởi động của Windows.
• Tích hợp Start Menu Manager giúp bạn giữ sạch Start Menu.
• Thu thập các thông tin chi tiết về các ứng dụng ngay cả trong trường hợp nó tự ẩn sâu trong các thư mục, đặc biệt hữu dụng cho việc tìm kiếm các ứng dụng “Gián điệp”.
• Sao lưu/Phục hồi thông tin các hứng dụng cài đặt.
• Tháo gỡ cài đặt với chức năng kéo-thả! Chỉ cần thả một file lên biểu tượng Your Uninstaller! trên desktop và bạn sẽ thấy những gì xãy ra!
• Liệt kê các ưng dụng đã được cài đặt với các biểu tượng thích hợp (giống như bạn thấy trong Start Menu), bạn có thể tìm ứng dụng mà bạn muốn tháo gỡ dễ dàng.
• Tính năng tìm kiếm mạnh mẽ cho phép bạn tìm chương trình bạn muốn tháo gỡ nhanh chóng.
• Tự động dò tìm các sự cài đặt không hợp lệ và tháo gỡ chúng chỉ với một cú click.
• Gỡ bỏ bắt buột các giá trị nạp vào trong registry liên quan đến việc tháo gỡ cài đặt (cẩn thận khi dùng)
• Khởi động cực nhanh, từ 5-10 lần nhanh hơn Add/Remove Program của Windows XP!
• Xem tất cả các chi tiết của một ứng dụng nào đó được cài đặt trên máy tính của bạn.
• Xuất danh sách các chương trình thành file hoặc in ra.
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